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Table of Contents

This manual is divided into three sections, a Preface, a User Guide and a Reference section.

The Preface contains information all users should be sure to read. Installation details and a
general introduction appear here, as well as hints and tips for organizing your disks to work
well with SmartCat's approach.

The User Guide presents a guided tour of SmartCat's features and facilities and covers most
of the things a new user will need to know to be comfortable with SmartCat for day-to-day
use. The user guide is designed in the form of an exercise you can follow at your PC while
actually using SmartCat. Have a blank pre-formatted floppy disk ready (any density will do).

The reference section provides more in-depth explanations of each of SmartCat's menu items
and commands, a list of Keyboard shortcuts, and instructions for customizing SmartCat and
performing  problem  determination.  Every  user  should  read  this  section  once  they  are
comfortable with the concepts presented in the User Guide.   

This is the Shareware version of the manual. 

The printed version that you receive on registration includes screen shots during each step of
the guided tour, and is fully indexed for ease of use.
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Disclaimer
Welcome to SmartCat Plus (hereafter referred to simply as "SmartCat" for sake of brevity).
SmartCat is a sophisticated floppy disk/CD-ROM/Hard disk/Network cataloging system for
Microsoft Windows. It requires Windows version 3.1 or later.

This software is supplied as is without warranty or representation either express or
implied  with  respect  to  the  program  or  its  documentation  including  their  quality,
performance, merchantability, or fitness for a particular purpose. 

In no event will Oakley Data Services be liable for direct, indirect, special, incidental, or
consequential damages arising out of the use of or inability to use the program.

Microsoft is a registered trademark of Microsoft Corporation.
MS-DOS is a registered trademark of Microsoft Coropration.
Windows is a trademark of Microsoft Corportaion.
BookManager is a registered Trademark of International Business Machines Corporation.

All other trademarks are acknowledged. If we have failed to mention one we apologise. 
Please let us know and we will correct it at our first opportunity. 
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Installation
If you received this product on disk or from a bulletin board/online service there should have
been an INSTALL.EXE program included. If you execute that program from either the File
Manager or Program Manager it will lead you through the installation process, including  de-
compressing  and  copying  the  required  files  and  creating  a  Program Manager  group  for
SmartCat. You cannot simply use the files as received, because they are compressed and
require decompressing, which is performed by the INSTALL.EXE program.

If you intend to re-dsitribute this package, please make sure you distribute all the files. If using
network, BBS or similar distribution methods it is probably best to Zip them so none can go
astray. If using disk (i.e. to include on a magazine cover disk, or in a book) then there is little
size advantage to Zipping, and it may be simpler simply allocate them a directory of their own
from where the user can immediately use the INSTALL.EXE program.

Please be sure to take the time to read the .TXT files that came on the disk. They contain
information that is not always repeated elsewhere. You can use the Notepad program from
the Windows Accessories group to view the files.
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Introduction 
Categorising your disks 

Getting the best from SmartCat needs some thought about the best way to organize your
collection of floppy disks or CD-ROMS. Even if you only have a few disks or ROMs now, it
won't be long before your collection grows substantially.

Whilst SmartCat doesn't have any particular limit to the number of disks it will catalog in a
single catalog (apart from the amount of memory you have, and the amount of disk space
available to store the catalog) it probably isn't sensible to keep all your disks cataloged in one
catalog. We would suggest you catalog your disks based on their "category". Some of your
disks  will  have  come  from  Software  Manufacturers,  such  as  your  DOS  and  Windows
distribution disks, and you are never likely to write new or amended files to them. Others will
be  disks  that  have  come from Shareware  libraries,  and  again  writing  to  them would  be
unlikely. Others may have come from magazine cover disks, and would form a logical third
category. Then there will be those that you use as working disks, and perhaps others you
keep customer data/work on. 

We would suggest that you divide your catalogs based on the categories you consider most
sensible for your particular way of working. SmartCat supports the merging of catalogs for
searching and reporting purposes, so you can always simulate a single catalog if you need to.

Even more thought  might  be required when it  comes to  CD-ROMs,  because of  the vast
amounts of data they can contain. The best course of action really depends on the sort of CD-
ROMs you are dealing with. If a CD-ROM contains a vast number of "smallish" files, like a
collection of  Clip-Art,  then  the best  approach might  be to  put  it  in  a  catalog  of  its  own.
Similarly large collections of shareware can simply overwhelm and individual catalogs might
be the approach to avoid extended processing times. You can always merge multiple CD-
ROM catalogs if you need to for searching purposes.

Also consider the time it might take to catalog a CD-ROM, depending on what you are asking
SmartCat Plus to do. If every file on the CD-ROM is zipped then SmartCat Plus is going to
have  to  read  pretty  much  ALL the  data  on  the  CD-ROM to  catalog  it  if  you  want  it  to
analyze .ZIPs, and that can take many minutes because CD-ROMs are not the fastest of
devices. Likewise if you install a lot of extension DLLs then the catalog time may extend if
they have significant processing to do. If SmartCat does need to read  all of a 650Mb CD-
ROM, and it has the usual transfer rate of around 150K/sec it will take SmartCat at least 72
Minutes, and probably longer, to get through it. You can of course switch away from SmartCat
while it is doing it, and there is the advantage that data on a CD-ROM doesn't change, so you
will probably only need to do it once!

Labeling your Disks 

SmartCat can print disk labels for you, using any label stock you have to hand. For further
information see the Label Menu instructions. However, for a large number of your disks you
probably want to be able to see the original label, and wouldn't want to stick another label on
top. In these cases we suggest you simply write the volume number that SmartCat allocates
the disk when you catalog it onto the original label with a felt tip pen or similar. If you then
store your floppies in numerical order within category it will be a simple task to find any one of
them.  Alternatively,  most  stationers  sell  small,  nicely  printed  stick-on  labels  in  ascending
numerical sequence which you can stick discretely over a corner of the original label.

Copyright © 1992,1993 by Oakley Data Services - All rights reserved.
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First Steps

Be Prepared

If you intend to follow this guide through on your PC, have a blank pre-formatted floppy disk
ready (any size will do). We will perform most of SmartCat's functions using your hard disk.
Although your major use of SmartCat will  probably be to keep track of your  collection of
floppies, because you are running Windows there are files that are bound to be on your hard
disk that will ensure the guided tour is appropriate to you.

Starting SmartCat

The first thing to do is to start SmartCat, so double-click on the SmartCat Icon, and after any
introductory screens SmartCat's main window will appear.
 
The outer  window is  known as the "frame window",  and inside it  (with  the caption "New
Catalog") is a "child window". SmartCat uses three different sorts of child windows, a catalog
window, a  disk window and a  search window,  and we will  meet  them all  as we explore
SmartCat's facilities. There can only be one  catalog window,  but there can be many  disk
windows and search windows. 

As well as being able to minimize the whole SmartCat Application by pressing the down arrow
in  the  top  right  corner  of  the  frame  window,  because  SmartCat is  an  MDI  compliant
application, you can also minimize the individual child windows. Try it now by pressing the
down arrow at the top right of the catalog window. Then return the Icon to a normal window by
either  double-clicking  on  it  or  single  clicking  and  selecting  the  Restore option  from  the
resultant floating Menu. 

It is worth making sure you understand how to manage windows in an MDI application, so if
you are unsure please read the "Two Kinds of Windows" section of the "Basic Skills" chapter
of your Windows Documentation. 

As it stands, SmartCat displaying an empty Catalog Window is not very interesting. What we
need to do is catalog a disk.

Copyright © 1992,1993 by Oakley Data Services - All rights reserved.
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Cataloging a Disk

Select the  Add Disk menu item from the  Maintain drop down menu, and a dialog box will
appear.

In the "Drives" list box in the top left hand corner select the hard drive which contains your
Windows  Directory  (probably  "C").  Ensure  "permit"  is  selected  as  the  "Unlabelled  disks"
option, "Verbose" is checked for the "Reporting Mode", all the "Archive Analysis" boxes are
checked, "Preliminary Virus Scan" is set to "no" and all the "Auto File Comments" boxes are
checked. Also ensure that the "Stack Label" option is checked. Type into the "Disk Comment
Field" an appropriate comment. Then press the "ADD" button and SmartCat will proceed to
read your hard disk and catalog all the files on it. Whilst SmartCat is reading your hard disk
you can if  you wish use Windows multi-tasking capabilities to switch to another program.
When SmartCat has finished reading your disk it will pop back to the front of the other display
automatically. Each file will be listed in the window at the bottom of the Dialog Box as it is
cataloged, as will the content of any archive files on your hard disk. The final message in the
window will be "Disk 1 cataloged". 

The Dialog Box will not go away however, and you need to press the "DONE" button. If you
were cataloging floppy disks you could simply insert  another floppy and click  on "OK" to
catalog a second disk, and keep repeating the process until you reached the end of the pile.

Your display will now be showing a single line in the  catalog window. From left to right the
fields  displayed  are;  the  disk  number  as  assigned  by  SmartCat;  the  disk's  label  (or
[Unlabelled] if it has no label); the size of the disk in bytes; the free space in bytes; the date
and time of cataloging and the drive used for cataloging. There may be a horizontal scroll bar
along the bottom of the catalog window to allow you to see anything off to the right (unless of
course you are lucky enough to have a large monitor).

Listing the files on a disk

Now we have a cataloged disk we can start to use SmartCat to find various files and to
process them. Let us start with a simple choice, listing all the files on a disk. There are two
ways to list all the files on a disk. Either select the disk by clicking on it once in the catalog
window (it will then highlight) and select the "Volume Contents" menu option from the "View"
menu, or more simply double-click on the disk in the catalog window. As we only have one
cataloged disk, double-click on it and a new disk window will appear after a few seconds. (On
floppy disks the Window will  normally appear instantly,  but hard disk lists can take a few
seconds).

From left to right the fields show; the filename; the file size in bytes; the file date and file time;
the drive used to catalog it and the file's path from the root directory of the disk.

As before you can scroll right to see any information out of view, and up and down to see
more files. 

There is a limit to the number of entries that SmartCat will list (not maintain) of 6,500 in any
child window, and it is possible that your hard disk may contain more files than that in which
case you will have got a warning message and a partial list. It is unlikely that you would make
sense of such a large list anyway, but this is ideal for experimentation. (Note that 6,500 is the
maximum number SmartCat will LIST, not maintain - SmartCat has recorded ALL the
files on the disk - it just won't show more than 6,500 in a single window).

Copyright © 1992,1993 by Oakley Data Services - All rights reserved.



SmartCat Plus Release 1.50 Page   8  

Sorting the list 

At this point it might be interesting to sort the list of files into different orders. Remember, this
is a Disk Window, so we need to specify the order we want the Disk Window to display in.

Select  the  "Options  Menu",  and  then  the  "Disk  Sort  Order"  submenu,  and  you  will  be
presented with several possible choices for the order you want the files listed. Experiment
with the different choices, noting the way the display changes. Each sort may take a few
seconds if the list is extremely large - on floppy disks such sorts are usually instantaneous.

Statistics

Now make sure the  Disk Window "has the focus" (has a highlighted title bar, and is at the
front - click somewhere on the  Disk Window if necessary) and select the "Statistics" option
from the "View" menu. A display giving statistics about the selected disk will appear.

The "Statistics" option is one that affects the window which has the focus. Try clicking on the
Catalog Window to give it the focus (its title bar will highlight and it will move to the front) and
select the statistics option again. This time a different display will  appear, giving statistics
about the whole catalog. 

Searching the Catalog

Let's now try finding some files using SmartCat's sophisticated searching facilities. Select The
"Search" menu item, and then select the "Simple Search.." option. A dialog box will appear.

Enter  W*.EXE  into  the  dialog  and  press  the  OK  button.  A status  dialog  with  a  moving
percentage bar will appear and display the progress of the search, at the end of which a new
child window, a  Search Window will appear. The  Search Window will display all those files
that  met  the  "search  argument"  (W*.EXE)  that  you  entered.   Note  the  * in  the  search
argument. The * is known as a "Wildcard" and means "any sequence of characters from here
to the end of this section of the filename". The other possible Wildcard is a ?, which means
"any single character in this position". See your DOS documentation for more details about
wildcards.

Again, you can sort the list of files in the Search Window by using the "Search Sort Order"
suboption of the "Options" menu.

More Complex Searches 

If  the simple search option doesn't  narrow the list  down sufficiently,  you can undertake a
"complex" search which additionally  allows you to  specify ranges of  dates and file  sizes.
Select the "Complex Search..." option from the "Search" menu, and a different Dialog Box will
appear.

Enter *.* as the filename pattern, 200000 as the minimum size and 300000 as the maximum
size, and press the OK button. A further search window will appear showing those files in the
catalog with a size of between 200000 and 300000 bytes.
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Adding/Changing Disk Comments

Let's now go back and change the comment for this disk we have cataloged. Click on the
Catalog Window to give it the focus. Make sure the one cataloged disk is still selected (i.e.
highlighted) and select the "Modify Comment" option from the "Maintain" menu. A dialog box
will appear.

Enter a suitable comment (up to 240 characters - the Dialog Box will beep if you try to enter
more) and click on the OK button. The comment will be added to the SmartCat database, but
you won't be able to see it yet. What you now need to do is select the "Catalog Display Style"
option  from the  "Options  Menu"  and  select  the  "Switch  Display  Mode"  choice.  A further
Submenu will appear that allows you specify the sort of display you want to see from where
you can experiment with the four possible choices.

Adding a File Comment

Just as individual disks can have comments associated with them, so can files. This can be
extremely useful, as it is not always obvious simply from the filename what the actual content
of the file is. If for example you do work for a variety of different people you may like to add
the  client's  name and  address  to  the  files  you  create  for  them.  To  experiment  with  File
Comments we need a file selected in either a Disk Window or a Search Window. Click on the
Search  Window  to  bring  it  to  the  front  and  see  if  you  can  locate  and  select  the  file
WINFILE.EXE by scrolling down the list. It should be there as it is the Windows File Manager
program. Then select the "Modify Comment" option from the "Maintain" menu and a simple
dialog box will appear and you can fill in an appropriate comment. Note also the availability of
a  "Paste"  button,  which  enables  you  to  add  comments  that  have  been  placed  on  the
Clipboard  by  copying  or  cutting  from another  program.  If  you  press  the  OK button  your
comment will now be attached to the file and added to the database. 

If you now click the right mouse button whilst it is over the Search Window you will be able to
see the format of the display changing and your comment should be visible. Clicking with the
right mouse button over the active window is a short-cut way of changing the style of the
display, as we did earlier with the Options|Switch Display Mode menu selections.

There may also be a few other comments displayed, as SmartCat is able to detect and use
comments embedded in .ZIP and .ARJ files, and can use comments maintained by the 4DOS
product.  Custom  Extension  DLLs  can  also  supply  SmartCat  with  comments  to  use  for
particular files,  such as the true Font Names for .TTF True-Type font  files.  (See later for
further information regarding Custom Extension DLLs).

Managing Windows

At this point the display might be starting to get a bit messy. To clear it up, and allow for a little
experimentation,  select  the  "Window"  menu,  then  the  "Tile"  option,  and  see  how  the
arrangement of the child windows changes. Then try the "Cascade" option, and finally choose
the "Minimize all  windows" option.  Next  we are going to experiment with  SmartCat's  File
processing capabilities and we will need a list of files, so double click on the Simple: W*.EXE
Icon to restore just that child window and use the "cascade" option of the "Window" menu to
have it assume a reasonable size. 

Copyright © 1992,1993 by Oakley Data Services - All rights reserved.
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Processing Files

You should  be able  to  find the "WINHELP.EXE" file  somewhere in  the list  in  the  search
window (it is the program that drives the Windows Help facility), so scroll up and down using
the scroll bars to the right of the window until it comes into view.

There are two ways to indicate that you wish to process the file. Either single click on it and
select "Process File..." from the "Maintain" menu, or double-click on the file. Whichever way
you choose a dialog box will appear. 

Put the blank floppy (make sure it is not write protected) you prepared earlier into a floppy
drive (probably "A"), and using the list box at the top left, select that drive so that it appears in
the "Target Path Specification:-". Then press the "Copy" button and the file will be copied to
the floppy, with a progress indicator showing percentage complete.

Double-click again on the WINHELP.EXE file in the Search Window, but this time when the
Dialog Box appears press the "Run" button, and the Windows Help Program will start.  

Of course you would be more likely to use these facilities to copy files from floppies to your
hard disk. We don't know what is on your floppies, but if you use SmartCat at least you will!

For a discussion of what the other buttons do please refer to the reference section. Even if
you think they are obvious it is worth reading the reference section, because their actions may
change if the file they are dealing with is in an archive, or is itself an archive.

Saving the Catalog Data 

Having gone to all this effort you should now save the catalog data, ready for recall whenever
required. Apart from anything else, you will need to save it now to enable you to proceed with
the tour because our next step will be to merge the example catalog with the catalog you
have just created, and SmartCat will not allow you to merge a catalog into one which has
been modified and not saved. Select the "Save Catalog As..." option from the "File" menu and
the file saving dialog box will appear.

Locate a suitable directory and enter a suitable name for the catalog (TEST.CAT is probably
as good as any) and press the OK button and the catalog data will be saved. Then select the
"New Catalog" option from the "File" menu, and all the catalog data will be cleared (although
you of course have a copy on disk in the "TEST.CAT" file).

Now select the "Open Catalog..." option from the File menu, and using the displayed Dialog
Box locate the file you saved and click on O.K.  The catalog will then be reloaded. 

Merging Catalogs

SmartCat  allows  you  to  maintain  separate  catalogs  for  different  categories  of  disks,  and
merge them together for searching or reporting purposes, and that is what we will do now.
Whilst you have only created one catalog, an example catalog was supplied with the product,
and we will merge that with your catalog.

Select the "Merge Catalog..." option from the "File" menu and using the resultant dialog box
locate the supplied example catalog (it has the name EXAMPLE.CAT and would have been
installed in the same directory as the SmartCat program). Then press the OK button and the
example catalog will be merged with yours.
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The additional disks displayed are in fact a selection of disks supplied on the covers of UK
computer magazines. Notice that the display in the catalog window has changed, and now
includes the name of the owning catalog. 

It  is  possible  to  merge  up  to  255  catalogs  in  this  manner,  which  would  soon  leave  you
confused as to which catalog was which, so there is an option to display a correlation dialog
to jog your memory. Select the "Merge File Correlation" option from the "View" Menu and a
Dialog Box will appear to correlate catalogs to full file-names.

Note also that if you have multiple catalogs, you can load the first and merge subsequent
ones  automatically  from the  "Load  Catalog"  option,  because  the  list  box  allows  multiple
selections.  If  you  are  unsure  how  to  use  a  multi-select  list  box  refer  to  your  Windows
documentation.

Exporting and Printing Data

All that is left  now on our tour is to try exporting data to the Windows Clipboard, and to
produce some reports.

With the duplicate listing still with the focus, select the "Copy" option from the "Edit" menu.
The cursor  will  turn  to an hourglass,  and quickly  back to  an arrow.  If  you now start  the
Windows Clipboard Viewer program (usually in the Main Group in Program Manager), you
should see the listing on the Clipboard 

Because the Clipboard Viewer uses a proportional font by default,  the listing may appear
"wiggly". If you need to you can select the "OEM Text" option from the "Display" menu of the
Clipboard Viewer to force it to use a non-proportional font. 

You might also like to try pasting this information into another program like Microsoft Write.
Start the Write program (usually in the Accessories group in Program Manager) and select the
"Paste" option from the "Edit" menu of the Write program. The listing will appear in the Write
document.  

Back at SmartCat, with the duplicates list still with the focus, select the "Print" option from the
"File" menu, and a report of the list in the Search Window will be sent to the printer. 

There is also the option to call the printer's "Setup" dialog by selecting the "Setup Printer..."
option of the "File" menu. Owners of Laser printers such as the HP Laserjet Series might like
to try printing in landscape mode.

Now click on the Catalog Window (which now has the caption "Merged Catalog") to bring it to
the front with the focus, and try printing again. Notice the difference in the report. This time it
is a listing of the Disks in the catalog. Both the Copying to Clipboard and Printing functions
use the details from the window which has the focus. They also determine the order they will
print/copy the listing from the sort order of the Window with the focus. Try sorting the duplicate
list (a Search Window) by filesize and then printing it for an example.

Other Facilities
We haven't explored all of SmartCat's facilities in this short tour, but we hope we have given
you enough of a feel for the program to be able to use it effectively for your day to day needs.
The reference section contains full details of all SmartCat's commands and facilities, together
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with further technical  details and a more in-depth discussion of some points.  The printed
manual that comes with registration has screen-shots and further amplification of some points
to more fully explain all the options.

In particular, most users will find a need to understand SmartCat's optional Virus Scanning
feature (we strongly recommend that you check "foreign" disks for viruses).

Printing disk labels is also pretty straight-forward and is explained in the on-line help and later
in the reference section of this document. 

It wasn't possible for us to show how SmartCat lists files in and extracts files from archives,
because we couldn't guarantee you would have an archive file. You might like to try searching
the catalog you have created for files using search arguments of *.ZIP, *.LZH, *.PAK, *.ARJ or
*.ARC, and then selecting one and choosing the "Archive Internals"  option of  the "View"
menu. When you get the list of files in an archive try processing the file and pressing the
"extract" button.  Note that files which are in archives display using a different, usually light-
grey color. SmartCat uses the "disabled text" setting from the color option of the Windows
Control Panel utility for files in archives.

As  you  become  more  confident  with  SmartCat  you  will  probably  want  to  know  how  to
customise it. Most people wish they could automatically do some process with a file on a
floppy disk, like pass it to a particular program for printing in some fancy way, or spellchecking
or whatever, and with SmartCat's customisation facilities, now you probably can!  Full details
of how to customise and enhance SmartCat are in the reference section that follows.
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Keyboard Usage 
The following keyboard shortcuts are supported:- 

File - Open - Alt+O 

Edit - Copy to Clipboard - SHIFT + INS 
Edit - Find Next - F3 

Maintain - Add Disk - CTRL+A 
Maintain - Delete Disk - CTRL+D 
Maintain - Update Disk - CTRL+U 
Maintain - Renumber Disk - CTRL+R 
Maintain - Relabel Disk  - CTRL+L
Maintain - Modify Comment - CTRL+C 
Maintain - Process File - Enter 
Maintain - Default Action - Ctrl+Enter 

View - Volume Contents - CTRL+V 
View - Internal Files  - CTRL+I 
View - Statistics - CTRL+S 
View - Merge File Correlation - CTRL+M 

Search - Simple Search - ALT+S 
Search - Complex Search - ALT+C 
Search - File Comment Search - ALT+F 

Help - Index  - F1 
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File Menu Commands 
New Catalog 

Selecting New Catalog clears the current Catalog. If there are any unsaved changes a prompt
is issued to allow the catalog to be saved if required. 

Open Catalog(s) 

Selecting Open Catalog(s) presents a dialog box from which one or more catalogs stored on
disk can be loaded. If a catalog is currently open and  there are any unsaved changes a
prompt is issued to allow the current  catalog to  be saved if  required.  Then the standard
Windows File Open Dialog box is presented, but note that you can select one or more files
as the list-box is multi-select. If you select more than one file then the first selected file is
loaded, and all the other selected files are merged with it.

Save Catalog 

Selecting Save Catalog saves the current catalog to disk. The catalog remains open and you
can continue to work on it. Note that you cannot save a merged catalog.    

Save Catalog As 

Selecting Save Catalog As presents a dialog box in which specifications of where the current
catalog should be saved can be entered. 

Merge Catalog 

Selecting Merge Catalog presents a dialog box from which one or more catalogs stored on
disk can be specified. That catalog is then merged with the current catalog. There are certain
restrictions when the current catalog is the result of one or more merge operations. For a
more detailed description of these restrictions refer to the section Merged Catalogs. Note that
there is a limit of  255 on the number of consecutive merge operations 

Printer Font

Selecting Printer Font allows you to specify the font (and color if your printer is color capable)
that SmartCat will use to print any reports you request. Note that if you choose a large font
not all the data will neccessarily fit on the page!

Printer Setup 

Selecting Printer Setup presents the usual Printer Setup dialog box for the currently selected
printer.  To  change the  currently  selected  printer  use  the  Printers  option  of  the  Windows
Control Panel. 

Print 

Selecting Print will cause the details in the currently active window to be sent to the printer. If
for  example  a  Disk  Window,  containing  details  of  the  contents  of  a  cataloged  disk,  was
currently the front window then those details would be sent to the printer. The print will be in
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the same sort order as the data displayed in the window. For details of how to modify the
sorting order refer to the options menu command. 
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Exit 

Selecting Exit  will  terminate the program.  If  there is  any unsaved data a warning will  be
presented and the option to save the data given. 
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Edit Menu Commands 
Copy 

Selecting  the  Copy  command  will  copy  the  contents  of  the  current  front  window  to  the
Windows Clipboard . If, for example, a Disk Window containing details of the contents of a
cataloged  disk,  was  currently  the  front  window  then  those  details  would  be  sent  to  the
Clipboard.  The data will  be placed on the Clipboard in  the same sort  order  as the data
displayed in the window. For details of how to modify the sorting order refer to the options
menu command. 

Find 

Selecting  the  Find  command  presents  a  dialog  box  in  which  you  can  enter  text  which
SmartCat Plus will attempt to locate in the comments in the window which currently has the
focus, the search beginning at the 'top' of the window. If the text is found (case insensitive)
then the first entry found is highlighted. 

Find Next

Selecting the Find Next command repeats the last Find command, beginning the search at
the currently selected point and continuing to the end of the window.
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Maintain Menu Commands 
Add Disk 

Selecting the Add Disk command causes the Add Disk Dialog Box to appear. The dialog box
has options for specifying :- 

Whether to analyse the internal contents of ZIP,ARC,ARJ,LZH and PAK format archive
files. Each archive type is presented as an on-off toggle option, and clicking on it with
the mouse will switch its state. We would expect you would usually want to select these
options, but there may be times when a corrupt archive may cause problems and it will
be necessary to prevent SmartCat from attempting to read it (although if it is defective it
may be more sensible to delete it or fix it!). 

Whether to permit or query unlabelled disks. If you select query then an attempt to
catalog a disk which is unlabelled produces a further dialog box, from which you can
select to label the disk, allow it to be cataloged without a label, or cancel the cataloging
operation.  Choosing to permit  unlabelled disks causes the disk to  be cataloged as
[unlabelled]. Allowing the cataloging of multiple unlabelled disks slightly increases the
risk of processing an incorrect file. 

The Reporting Mode required. If set to "verbose" each file encountered is reported in
the message areas at the bottom of the dialog box. If set to "quiet" no files are reported.
If set to "auto" files are reported when cataloging disks on drives "a" and "b", but not
otherwise. Updating the message areas for each file can slow down cataloging a large
hard drive or a large CD-ROM quite considerably, but can be very useful for problem
determination purposes. 

If a preliminary Virus Scan is required. If set to "yes" a Virus Scanning program will be
called  before  the  disk  is  cataloged.  The  choice  of  virus  scanning  program is  user
configurable, and further details can be found in the customization options section.

Whether to "stack" a label for the disk about to be cataloged, so that  a label can be
printed later. Having this option checked does not commit you to actually print a label -
if you terminate SmartCat while there are still labels "stacked" then they are simply lost.
Similarly you can always stack a label for an already cataloged disk at a later time from
an option in the "Label" menu.  

Whether to try to extract comments automatically from .ZIP, and .ARJ archives, and
whether to attempt to detect Norton/4DOS comments (If you don't know what they are
you needn't worry about them).

The comment text you want associated with the disk.

Clicking on "ADD" then causes SmartCat to read the volume label of the disk. If an
unlabelled disk is found and the Unlabelled disk query option was selected the option to
continue, label the disk, or cancel the process is given. The current catalog is then
searched for a disk with a duplicate label, and if one is found the options to continue or
cancel are presented. Assuming continue, or no duplicates, the directories on the disk
are read and each file found is cataloged. If requested, the contents of Archive files are
also cataloged and internal comments retrieved. 

When the disk has been cataloged the dialog box remains on screen, ready for another disk
to be inserted and cataloged. When all disks have been cataloged the "DONE" button should
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be selected to end the process. 
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Delete Disk 

Selecting the Delete Disk command removes from the catalog the disk which is currently
selected in the  catalog window . A confirmation box is presented giving you a final chance to
confirm the action. 

Update Disk 

Selecting the Update Disk  command displays the same dialog box as in  the "Add Disk"
command. Having chosen the required options and pressed the "OK" button, the volume label
of  the disk in the drive is  compared to the catalog record for the disk which is  currently
selected in the catalog window . Assuming the labels match the disk is then processed as for
the "Add Disk" command, and the records for the disk replace those originally in the catalog.
Comments attached to files are preserved, providing the date/time, size, name and path are
identical. 

Renumber Disk 

Selecting the Renumber Disk allows you to change the catalog number of the disk which is
currently selected in the catalog window . A dialog is presented which allows you to enter a
new number. Providing the number you select does not already exist it will replace the current
volume number. The volume number must lie in the range 1 - 9999. 

Modify Comment 

Selecting Modify Comment allows you to add, delete or change the disk comment associated
with the disk which is currently selected in the catalog window or the file comment associated
with the file in the disk window or search window that has the focus . A dialog is presented
which allows you to enter a new comment. If you wish to delete an already existing comment
simply delete all the characters by pressing the backspace key when the dialog first appears
and then select "OK". 

Process File 

Selecting the Process File option displays a dialog box which allows you to specify actions to
take against the file which is currently selected in the search window or a disk window . For
further information see the section processing files . Note that selecting this menu command
is equivalent to double-clicking on a file in a search or disk window. 

Default Action 

Selecting the Default Action option (or using it's Keyboard shortcut Ctrl+Enter) causes the
default action DLL specified for the filetype which is currently selected in the search window
or  disk  window to  be  called  to  process  the  file.  For  further  information  see  the  section
"Enhancing SmartCat's Capabilities". As supplied, the default action for .WAV files is to play
the sound (if your PC is capable of playing .WAV files using the sndPlaySound API call - you
need a suitable sound driver). No other default  actions are enabled. If there is no default
action associated with the filetype selected then no action occurs. 

Copyright © 1992,1993 by Oakley Data Services - All rights reserved.



SmartCat Plus Release 1.50 Page   21  

View Menu Commands 
Volume Contents 

Selecting the Volume Contents command will create a new disk window which will display the
contents of the currently selected volume in the catalog window. 

Internal Files 

Selecting the Internal Files command will create a new search window which will display the
contents of the currently selected archive file in the disk window or search window which
currently has the focus, or display those internal files whose names have been returned by a
custom Extension DLL. If the currently selected file is not an archive or a file processed by a
custom Extension DLL then the menu option will not be available. 

Statistics 

Selecting the Statistics command will display a dialog box which will give statistical details of
the catalog window or disk window or  search window which currently has the focus. 

Merge File Correlation 

Selecting the Merge File correlation command will  display a dialog box which will  give a
cross-reference of  the catalog names in the catalog window to the catalog files they are
associated with. This option is only available after a catalog merge has been undertaken. 
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Search Menu Commands 
Simple Search 

Selecting the Simple Search command will display a Dialog Box in which you can enter one
or more filename patterns to search the catalog for. The search arguments you enter can
include  the  standard  DOS wildcards  *  and  ?  and  multiple  search  arguments  should  be
seperated by spaces. The results of the search will appear in a search window, from where
you can process any of the resulting files. 

Complex Search 

Selecting the Complex Search command will display a Dialog Box in which you can enter a
combination of arguments (one or more) on which to base the search of the catalog. The
search arguments are combined on an AND basis,  i.e.  a file  must meet all  the specified
arguments to be included. Possible arguments include:- 

The filename patterns to search the catalog for. The search arguments you enter can
include the standard DOS wildcards * and ? and should be seperated by spaces. 

The minimum file size (in bytes). 

The maximum file size (in bytes). 

The  earliest  filedate.  The  format  of  date  required  depends  on  the  setting  in  the
International section of the Windows Control Panel . If you are having trouble entering
dates  an incorrect  setting  in  Windows  is  probably  the  reason.  You can  change date
formats at any time. 

The latest filedate. 

The results of the search will appear in a search window , from where you can process any of
the resulting files. 

File Comment Search

Selecting the File Comment Search option presents a dialog box in which you can enter up to
3 text strings to search the recorded file comments for. The text strings are not case sensitive.
They can be combined on an and or an or basis by use of the radio buttons in the bottom left
corner of the dialog box. The dialog box "remembers" the last few search arguments entered
during a SmartCat session, and they can be recalled by use of the drop down arrows at the
right.

The results of the search will appear in a search window, from where you can process any of
the resulting files. 
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Options Menu Commands 
Catalog Sort Order 

Selecting the Catalog Sort Order command presents a further sub-menu which allows the
specification of the sort order required for the catalog window . If the catalog window currently
has the focus then the new sort order will take effect immediately. If another window has the
focus, then the new sort order will take effect when the catalog window gains the focus.  The
specified sort order also affects the order in which entries will  be printed or copied to the
Windows Clipboard . 

Sorting is  possible  by volume number,  volume name, volume freespace,  by the date  the
volumes were cataloged, or by the comment text associated with the volume. 

Disk Sort Order 

Selecting  the  Disk  Sort  Order  command  presents  a  further  sub-menu  which  allows  the
specification of the sort order required for the disk window(s) . If a disk window currently has
the focus then the new sort order will  take effect immediately.  If  another window has the
focus, then the new sort order will take effect as disk window(s) gain the focus.  The specified
sort order also affects the order in which entries will  be printed or copied to the Windows
Clipboard . 

Sorting is possible by file name, file extension, file size, file date, directory name or associated
comment text. 

Search Sort Order 

Selecting the Search Sort  Order command presents a further sub-menu which allows the
specification of the sort order required for the search window(s) . If a search window currently
has the focus then the new sort order will take effect immediately. If another window has the
focus,  then the new sort  order  will  take effect  as search window(s)  gain the focus.   The
specified sort order also affects the order in which entries will  be printed or copied to the
Windows Clipboard . 

Sorting is possible by file name, file extension, file size, file date, disk name, disk number,
directory name or associated comment text. 

Catalog Display Style 

Selecting the Catalog Display Style command presents a further sub-menu which allows the
specification of the display style required for the catalog window . The available options are to
display disk comments, or to display data about the disk such as freespace, time and date of
cataloging etc. If the catalog window has the focus then the new sort order will take effect
immediately.  If  another window has the focus, then the new sort  order will  take effect  as
search window(s) gain the focus. 

Hide/Show Internal Files (Disk Windows)

Selecting  the  Hide  Internal  Files  (Disk  Windows)  or  Show Internal  Files  (Disk  Windows)
commands changes the display style of Disk Windows, by either displaying or not displaying
those files which are internal components of another file (i.e. the internals of Archives such
as .ZIPs or .ARJs, or any internal filenames provided by custom extension DLLs such as the
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internal files in a DOS6 backup, or the internal content of BookManagerTM bookshelves).
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Separators

Selecting the Separators command allows the specification of  the type of  lines to use to
separate each entry in Catalog, Disk and Search Windows in each of the different display
modes. The choices presented are for no lines, dotted lines, dashed lines or solid lines.

Switch Display Mode

Selecting the Switch Display Mode option allows you to change the mode of display for the
window that has the focus from data (showing name, sizes, dates and times etc.), to short
data (just name, path and drive), to comment (just name and comment text (if any)), to data
and comments (all data and comment text (if any)) spread over two lines. Note that you can
also cycle through the display modes of the window that has the focus by ensuring the mouse
pointer is over the window and clicking the right mouse button.

Play Sounds

Selecting the Play Sounds option enables or disables SmartCat's use of sounds for various
events such as "Search Complete",  "Disk Update Complete" etc..  If  the use of sounds is
enabled then there will be a tick by this menu item. 

Note that you need a device driver capable of playing .WAV files to make use of this option. If
you enable SmartCat sounds and do not have a suitable driver installed you will get a dialog
box detailing the failure the first time SmartCat attempts to play a .WAV file, and the option will
be automatically disabled. 

If you do not have a suitable sound card you might like to consider obaining the Microsoft
Windows Speaker Driver which will play .WAV files through your PC's internal speaker. The
Speaker Driver is available from most BBS's and good shareware sources. 

You can select which .WAV files accompany which SmartCat events by use of the "Sounds"
Control Panel Applet.
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Label Menu Commands
The Label Menu Commands implement SmartCat's Label printing facilities.

Clear Label Stack

Selecting the Clear Label Stack option clears all the currently recorded label information. The
option is only available if there are some disk labels currently in the "stack" awaiting printing.

View Label Stack

Selecting the View Label Stack option displays a dialog box giving a list of the disks currently
having a label "stacked" for subsequent printing. You can delete the stacked label for any of
the displayed disks.

Select Label Printer

This option allows the specification of the printer to use to subsequently print labels.

Stack Selected Disk

Selecting the Stack Selected Disk option will add, to the label stack, label details for the disk
which is currently selected in the Catalog Window. 

Note that you can stack more than one label for a selected disk if that is useful to you, or go
back and delete one using the View Label Stack option should you do so by accident.

Stack All Disks in Catalog

Selecting the Stack All Disks in Catalog option will add, to the label stack, label details for all
the disks in the current catalog. Again you can do this multiple times if it is useful.

Stack Manual Label

Selecting the Stack Manual Label option presents a dialog box into which you can manually
type details you want to appear on the label. The detail you type in the "Header" box prints in
the "Header" font, the detail typed in the "Body" box prints in the "Comment" font, and the
detail typed in the "Footer" boxes prints in the "Data" font. 

Print Stacked Disk Labels.

Selecting the Print Stacked Disk Labels option presents a Dialog Box which has a number of
fields used to describe to SmartCat the dimensions of the labels you have. Two of the popular
Avery brand label dimensions are pre-configured, although there are always minor differences
between different printer brands and you may have to make slight adjustments. 

Note that it is up to you to define fonts of an appropriate size to ensure that all the information
fits on the size of label you have defined. SmartCat will  "wrap" the comment text  to fit  it
between the header and data parts of the label, but makes no attempt to wrap the header or
data themselves.
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Selecting the "OK" button will then cause the labels to print.
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Window Menu Commands 
The Window menu subcommands implement the normal window management commands for
MDI windows, with some extensions particularly relevant to SmartCat. For further information
about general window management refer to your Windows documentation. 

Cascade 

Selecting Cascade re-arranges all non-minimized windows in an overlapping fashion. 

Tile 

Selecting Tile re-arranges all non-minimized windows in a tiled fashion, where all the space in
the client window is used, but no windows overlap each other. 

Tile on Top. 

Selecting Tile on Top re-arranges all non-minimized windows in a tiled fashion, where all the
space in the client window is used, but no windows overlap each other. Priority is given to a
horizontal arrangement.

Arrange Icons 

Selecting Arrange Icons causes any minimized (iconised) windows to re-arrange themselves
neatly at the bottom of the client window. 

Minimize all Windows 

Selecting Minimize all Windows causes all open windows to assume the minimized (iconised)
state. 

Restore all Windows 

Selecting Restore all Windows causes all minimized windows to assume the normal state. 

Close all Search Windows 

Selecting Close all Search Windows causes all  search windows (minimized, maximized or
normal) to close. 

Close all Disk Windows 

Selecting Close all Disk Windows causes all  disk windows (minimized, maximized or normal)
to close. 

Close all Windows except Catalog 

Selecting Close all Windows except Catalog causes all  open windows (except the catalog
window) to close. You cannot close the catalog window. 
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Processing Files 

General Information

Once you have located the file(s) you are interested in, either in a disk window or a search
window you can process the file in a number of ways. Having put the disk in question into the
drive (unless the file is on a hard disk) double clicking on the file name will present a dialog
box from where you can specify what action you wish to take. 

The dialog box that is presented details at the top the name of the file, the number of the disk
it is on, the volume label (if it has one), and the default drive in which it expects to find it. 

To the right of the dialog box is a list box showing the available drives on your system, and
you can select an alternative drive from which to process the file if desired.

To the left of the dialog box is another list box, and just above it the words "Target Path:-". The
target path defines where any action which creates a further file or files will place those files.
For example, the "Explode" option, which extracts all the files from an archive, will place the
resultant files as specified by the "Target Path" specification. You can change the target path
specification by use of the list box. The target path you specify is remembered from session to
session. 

Slightly to the right of the centre of the dialog box are two on/off toggle options. Minimize on
Use, if checked, causes SmartCat to shrink to an icon if another program is launched by use
of the Run or Process buttons. Confirm Deletes, if  checked, issues a warning before any
destructive operation is undertaken on any file.

Towards the bottom of  the Dialog Box are a group of  process-option buttons.  The first  9
provide different options, and are enabled and disabled as appropriate for the type of file
selected. If the selected file is part of an archive, the text of some of the buttons will change to
be preceeded by an "X" signifying that the file will first be extracted from its archive to the
target path before the action is undertaken.

Delete will attempt to delete the file. 

Rename will attempt to rename the file. 

Copy will attempt to copy the file to the specified target path. 

Move will attempt to copy the file to the specified target path, and then delete the original. 

Run (which is only enabled if the file is executable), will attempt to execute the file. 

Process (which is only enabled if the file is associated with a particular program (use the File
Manager  File|Associate  option  to  associate  files  to  programs)  -  see  your  Windows
documentation) attempts to launch the associated program with this file as its input.

Extract attempts to extract this file from the archive it is in to the target path. This option is
only enabled if the file is in an archive. 

Explode attempts to extract all the files from this archive to the target path. This option is only
enabled if the file is itself an archive. 
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Print attempts  to  print  the file  to  the current  Windows printer.  The font  used is  the  one
selected from the File|Printer Font option

The remaining buttons are user-definable. For more information see the customization details
section. 

Customisation Details 

SmartCat can be customised to suit your needs, and the way you like your system to work.
The main areas where you can customise SmartCat are in the way it performs pre-catalog
virus scanning, the way it performs extraction from archives, and what effect pressing any of
the "User" buttons in the Process File dialog box has. All are customised by modifying the
SMARTCAT.INI file which is distributed with the product. 

Pre-Catalog Virus Scanning 

In your SMARTCAT.INI file you will find the following line:- 

ExSCAN=SMCATDOS.BAT SCAN %d /NOMEM 

The detail after the = sign is the command SmartCat will issue to cause a virus scan of the
disk. The %d parameter will be replaced with the drive designation (e.g. a:) for the drive to be
used for cataloging. As delivered SmartCat will call the supplied SMCATDOS.BAT file which in
turn will call the McAFee Scan program with the memory checking option disabled. Note that
the  SCAN program is  not  supplied  as  part  of  SmartCat,  but  is  available  from all  good
shareware sources. If required you can modify this command to suit your needs, perhaps by
calling an alternative virus scanner. 

Archive Processing 

In your SMARTCAT.INI file you will find the following 5 lines:- 

ExZIP=SMCATDOS.BAT PKUNZIP -O 
ExLZH=SMCATDOS.BAT LHA E /C 
ExARC=SMCATDOS.BAT ARC-E 
ExPAK=SMCATDOS.BAT PAK E 
ExARJ=SMCATDOS.BAT ARJ E 

Each of these lines represents the beginning of the command that SmartCat will  issue to
invoke the relevant archive extraction program. SmartCat appends the archive file name and
target path name as required. If you wish you can modify these commands to more suit your
way of working. For example you may wish to use the "ARC" program to extract "ARC" files
rather than the "ARC-E" program which is the default. If so modify the ExARC line to read
"ExARC=SMCATDOS.BAT ARC E ". Similarly, the commands above assume the extraction
programs can be found somewhere in a directory in your PATH . If this is not the case you
may  wish  to  add  drive/directory  information  to  these  commands.  Note  that  the  archive
extraction programs are not  supplied as part  of  SmartCat,  but  all  are  freely  available  as
shareware from good shareware sources. 

Defining "User Buttons" 

In your SMARTCAT.INI file you will find pairs of the following type of lines:- 
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User1Btn=&View 
User1Cmd=Notepad.exe %f 

The UsernBtn= line defines, for each user button, what will appear on the button face. The
ampersand (&) immediately precedes the character which will become the button's "hot-key"
(although there aren't many left to choose from, and if you duplicate one that already exists in
the dialog box the original will take precedence). If the file is actually in an archive, SmartCat
will automatically add the character X to the start of the button text (and will extract the file
first if you push the button!) 

The User1Cmd line defines what command will be issued when the button is pressed. In the
command the following characters can be used which will be replaced by SmartCat before the
command is issued:- 

%f SmartCat will insert the name of the file, including its full pathname.

%t SmartCat will insert the target pathname selected in the process file dialog box. 

%n SmartCat will insert the filename, excluding its path.

%p SmartCat will insert just the path to the file, excluding the filename.

For example, assuming you had a super-wizzo editor called WINWIZZO, and you wanted to
modify user button 3 to call it, you would need something along these lines:- 

User3Btn=&WinWizzo 

User3Cmd=WINWIZZO %f

Note  that  as  delivered  the  first  user  button  has  been set  up  as  &View,  and  it  calls  the
NOTEPAD program. The second user button has been set to call the McAFee virus scanning
program SCAN via the SMCATDOS.BAT interface batch file. All the other user buttons are set
up to call the WRITE program. 
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Enhancing SmartCat's Capabilities
General

SmartCat's capabilities can be extended by the addition of custom Extension DLL's (like "sub-
programs" really), which can be used to enhance SmartCat's understanding of the internal
formats of particular types of files by returning additional information about them. 

SmartCat can then use that information to either record any additional internal files that the
DLL has discovered exist inside files of that type, or to extract useful information to use as file
comments.

SmartCat's abilities can also be enhanced by the addition of further "Default Action DLL's" to
provide specialised processing for particular file-types.

For example, if a new archive format comes along and becomes popular it should be possible
to add a DLL to SmartCat to enable it to determine the internal content of those types of files.
Similarly it should be possible to construct DLL's to extract useful information such as Author
Name, Document Title etc. from word processing document files. 

At the time of writing several DLL's were under development or already complete. Any DLLs
shipped with this product will be seperately documented (look for other .WRI files - or the
install program may have added Icons for DLL documentation during installation).

Some potential uses for these sorts of DLLs might include:-

Analysis of the internal content of DOS6 backups to determine and record the files in the
backup, and as a comment the details of the backup set. 

Analysis  of  BookManagerTM Bookshelf  files  (.BKS,  normally  supplied  on  CD-ROM),
determining the books (.BOO files) that constitute the bookshelf and returning as comments
both the bookshelf title and the individual book titles and publication numbers and dates. 

Analysis of TrueType font files to return as a comment the true name of the font.

Analysis of the size and resolution of graphics files (.PCX, .BMP, .GIF, .DIB etc..etc..).

We intend  to  continue  to  produce  useful  DLLs,  and  will  inform registered  users  of  their
availability. 

We are also actively looking for any suggestions you have for types of files that would make
suitable candidates for analysis by SmartCat DLL's. If you do have an idea for a useful DLL
that we haven't yet produced (call us first to find out!) then it is far more likely that we can
produce something if you can obtain the format of the file for us, and send us some examples
of  that  type  of  file.  Obviously  we don't  have access  to  every  possible  variation of  Word
Processor, Spreadsheet etc. etc.., nor always an understanding of every type of package that
produces files! Contacting the manufacturer of the package may bring you the layout of the
files, or then again it may not. In our experience some manufacturers are very helpful, and
some are not.

Please note that none of the foregoing is a commitment on our part to produce specific
DLLs, or in fact any more at all, although it is currently our intention to do so provided
we believe they are commercially  viable.  Also,  extension DLLs will  not necessarily
always be released as Shareware.
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Adding Custom Extension DLLs

To add a DLL to SmartCat to analyse a particular type of file refer to the instructions that
came with the DLL. There may be an Install procedure that came with the DLL that will effect
the complete installation for you.  If  you have to install  a DLL manually all  that  is  usually
required is to edit the SMARTCAT.INI file (held in your Windows Directory), and add to the
[Extensions] section a line of the format:-

.xxx=DLLNAME1,DLLNAME2,DLLNAME3

where .xxx is a file extension (leading dot required), and

DLLNAME1,DLLNAME2,DLLNAME3 

are the names of custom DLLs to be called to process this type of file.

if the [Extensions] section does not exist in your SMARTCAT.INI file you can simply create it.

Note that more than one DLL can be associated with a particular filetype. The DLL's will be
called in sequence until one responds that it understands the format of file presented to it. No
further DLLs will then be called for that particular file.

Also note  that  the Shareware version of  SmartCat  only  recognises the first  Custom DLL
specified in the [Extensions] section. The registered version is capable of recognising multiple
DLLs.  You  may wish  to  change the  coding  order  in  your  SMARTCAT.INI  file  in  order  to
experiment.

It is also possible to associate a DLL with one particular file, by coding a line of the format:-

complete.fil=DLLNAME1,DLLNAME2

The DLL is not actually restricted to recording anything specifically related to the file, and
could be used to record almost anything as a comment for a particular file, for example the
temperature at the time the catalog was run (with suitable hardware!). This technique can be
used to good effect  particularly in networked environments or where Notebooks are used
away from the office, where for example it could be used to determine the amount of Ram
installed  on  Workstations  for  analysis  by  a  Network  Administrator.  Further  information  is
available  in  the  manual  that  accompanies  the  separate  SmartCat  Auditing  Extensions
product.   

Adding Additional Default Action DLLs

Additional Default Action DLLs can enhance SmartCat's ability to process certain types of file.
An example of this process at  work is with the SCWAVPLA DLL supplied with SmartCat,
which can play .WAV files directly without the need to start the Sound Recorder applet, press
the play button, and then close sound recorder down again. If you have any ideas for useful
Default Action DLL's please let us know. (E-Mail of some sort is easiest for us, or a message
in the WINSHARE forum on CompuServe which we check regularly, but we are also happy to
take phone calls!).
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To add a DLL to SmartCat to provide a new default action for a particular type of file refer to
the instructions that came with the DLL. There may be an Install procedure that came with the
DLL that will effect the complete installation for you. If you have to install a DLL manually all
that is usually required is to edit the SMARTCAT.INI file (held in your Windows Directory), and
add to the [Actions] section a line of the format:-

.xxx=DLLNAME

where .xxx is a file extension (leading dot required), and

DLLNAME 

is the name of the custom DLL to be called to process this type of file.

if the [Actions] section does not exist in your SMARTCAT.INI file you can simply create it.

The Shareware version of SmartCat only recognises the first Default Action DLL specified in
the [Extensions] section. The registered version is capable of recognising multiple DLLs. You
may wish to change the coding order in your SMARTCAT.INI file in order to experiment.
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Problem Determination 
SmartCat  has  gone  through  a  thorough  testing  process,  but  like  any  complex  piece  of
software there may be the odd bug still lurking. SmartCat also depends to some extent on the
integrity of the data (i.e the disks, and the files thereon) that are presented to it to catalog. 

If you discover a problem there are some things you can do to help narrow down the cause:- 

If the problem occurs while cataloging a disk first determine if the disk is actually readable by
the DOS DIR command (or the Windows File Manager). If they can't read it, it is almost ertain
the Directory Structure is corrupt. If there is no obvious problem try running the CHKDSK
command  against  the  disk  in  question  (refer  to  your  DOS  documentation  -  the  usual
command is CHKDSK a: to check the disk in drive "a") to see if  there are any structural
problems.

If the disk can be read OK by a DIR command and the Windows File Manager, and CHKDSK
suggests no problems, try cataloging the disk again with SmartCat but having turned OFF all
the archive analysis and auto-comment checkboxes. If SmartCat can now cope with the disk
it is almost certain that one of the archive files on the disk is corrupt. A process of elimination,
together  with careful  observation of  the message box in the Add Disk Dialog box should
enable you to narrow the problem down to a specific file. Once you have determined which
file causes the problem try to process it with its native utility and produce a list of the files the
archive contains. If this also fails you don't have many choices, either attempt to repair the
archive (some archives, like ZIP files, have a matching repair utility (PKZIPFIX)) or try and
extract what you can before you scrap it. 

If DIR and the Windows File Manager can cope with the disk, and there do not appear to be
any corrupt archives, please contact us for advice. We may already have a fix, or we may ask
you to send us the offending disk/file for further investigation. 

If you have any other problem with SmartCat not related to cataloging disks please let us
know and we will do our best to resolve them. Of course the problem may already be fixed in
the registered version. 

Before you contact us please have available all the facts surrounding the problem. It is much 
easier for us to help you if you let us know:-

If you can reproduce the problem, and can let us know the exact steps that cause it.

If any error messages are issued, and you tell us the exact content of them. Just saying "I get
an error message" will delay any response, because we will have to ask you what it said. If
you get "Someprog caused a General Protection Fault at ssss:oooo" then please note down
the address given (ssss:oooo).

Details of the configuration of your machine:- What chip (286,386,486,Pentium!). How much
memory, what Operating System, what version of Windows? What video cards/technology
(VGA, SVGA, S3, Wietek P9000)? Do you use compression software? Any TSR's? Are you
using Program Manager as the shell or something else? If you are using something else then
does the problem go away if you go back to Program Manager?   

If  the  problem has  only  just  started  happening,  and  if  you  have  changed  any  hardware
recently, or introduced any new software?
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